Arrays

An array is a container object that holds a fixed number of values of the same type. You could think of an array as one variable name that can hold an unlimited number of values. The length of an array is defined when the array is created. An array that holds five values is displayed in the figure below. Each value in the array is assigned an index number. An array always starts with zero (0). In this example the 5th value, A is assigned to index number four.

0            1           2             3            4

A B C D F

In the code example below there are two different array types defined. On line 6 an array of integers has been defined called grades. It does not matter which side of the name of the array the square brackets go. The statement can be written like this: int grades[]; You will see code examples with arrays written both ways. It is a matter of preference in which way you choose to write the array statement.

On line 7 the array is initialized with the size or length of 30. This would mean that the index numbers assigned to the values would be 0 – 29.

On line 9 the place holder or index zero (0) is assigned the integer 95.

```
class ArrayExamples{

    public static void main(String[] args)
    {
        int[] grades;  //Defines the array as an integer
        grades = new int[30];  //initializes the array with the size of 30
        grades[0] = 95;
        String[] daysOfWeek = {"Monday", "Tuesday", "Wednesday", "Thursday", "Friday"};

        System.out.println("Grade: " + grades[0]);
        System.out.println("Day: " + daysOfWeek[2]);

        for(int x = 0; x < daysOfWeek.length; x++)
        {
            System.out.println("Day Number " + (x+1) + ": " + daysOfWeek[x]);
        }
    }

}```

Line 11 defines an array of strings, initializes and assigns the values all in one statement. The days of the week are enclosed in the curly brackets and because they are string values they have double quotations around them.

Lines 14 and 15 are printing out the index of 0 for grades, the only one that a value is assigned to in this example and daysOfWeek’s index 2. The results will print Grade: 95, Day Wednesday.
Line 17 uses the for loop with the length command so that all values in the array will be printed out. On line 19 there is a calculation of $x+1$ to start off the Number of the week with 1 as shown in the code results below.

Button Arrays and Menu System

In this code example we will use some new features and concepts to create a calculator as shown in the figure below.

Private Variables

This application uses private variables to ensure that there will be no interference from any other class. These variables can only be used by this application and are define on lines 15 -23.
This application will also use `java.awt.datatransfer.*` to be used the menu system Edit feature to copy and paste data. The `DecimalFormat` will be used as a variable `calcPattern` to hold the pattern for the output display. When this variable is initialized on line 77 it will look like this:
```
calcPattern = new DecimalFormat("########.########");
```

A `Panel` is an AWT component that serves as an invisible container to further refine the placement of components within the container `Frame`.

A `Button Array` is defined on line 15 to hold the 16 values that will be used in the calculator.

The `Boolean` variable type will be used to set a true or false value when a button is clicked.

### Creating the Menu

To create the menu three different components are constructed as shown in the table below.

<table>
<thead>
<tr>
<th>Java Menu Components</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Menu Component</strong></td>
</tr>
<tr>
<td>MenuBar</td>
</tr>
<tr>
<td>Menu</td>
</tr>
<tr>
<td>MenuItem</td>
</tr>
</tbody>
</table>

After the components are constructed, then methods are used to assign and populate the menus. The table below displays some of the more common method used with menus.

<table>
<thead>
<tr>
<th>Menu Methods</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Method</strong></td>
</tr>
<tr>
<td>SetMenuBar()</td>
</tr>
<tr>
<td>add()</td>
</tr>
<tr>
<td>addActionListener()</td>
</tr>
<tr>
<td>setActionCommand()</td>
</tr>
<tr>
<td>remove()</td>
</tr>
<tr>
<td>insertSeparator()</td>
</tr>
</tbody>
</table>

This application will use three commands on the menu bar: File, Edit and About. The File menu item will only contain the Exit command. Edit will have three commands: Clear, Copy and Paste. There is a horizontal separator line between Clear and Copy. The About menu will only contain one command About Calculator.
It is common practice to use the prefix `mnu` when defining and constructing menu systems. The code below constructs and populates the menu used for the Calculator application. Line 28 create the menu bar and assigns the name `mnuBar`. Line 29 set the menu bar to the frame.

```java
public Calculator()
{
    // create an instance of the menu
    MenuBar mnuBar = new MenuBar();
    setMenuBar(mnuBar);

    // construct and populate the File menu
    Menu mnuFile = new Menu("File", true);
    mnuBar.add(mnuFile);
    MenuItem mnuFileExit = new MenuItem("Exit");
    mnuFile.add(mnuFileExit);

    // construct and populate the Edit menu
    Menu mnuEdit = new Menu("Edit", true);
    mnuBar.add(mnuEdit);
    MenuItem mnuEditClear = new MenuItem("Clear");
    mnuEdit.add(mnuEditClear);
    mnuEdit.insertSeparator(1);
    MenuItem mnuEditCopy = new MenuItem("Copy");
    mnuEdit.add(mnuEditCopy);
    MenuItem mnuEditPaste = new MenuItem("Paste");
    mnuEdit.add(mnuEditPaste);

    // construct and populate the About menu
    Menu mnuAbout = new Menu("About", true);
    mnuBar.add(mnuAbout);
    MenuItem mnuAboutCalculator = new MenuItem("About Calculator");
    mnuAbout.add(mnuAboutCalculator);

    // add the ActionListener to each menu item
    mnuFileExit.addActionListener(this);
    mnuEditClear.addActionListener(this);
    mnuEditCopy.addActionListener(this);
    mnuEditPaste.addActionListener(this);
    mnuAboutCalculator.addActionListener(this);

    // assign an ActionCommand to each menu item
    mnuFileExit.setActionCommand("Exit");
    mnuEditClear.setActionCommand("Clear");
    mnuEditCopy.setActionCommand("Copy");
    mnuEditPaste.setActionCommand("Paste");
    mnuAboutCalculator.setActionCommand("About");

    // construct components and initialize beginning values
    lcd = new TextField(20);
   lcd.setEditable(false);
    keypad = new Panel();
    keys = new Button[16];
    first = true;
    op1 = 0.0;
    clearText = true;
    lastOp = 0;
    calcPattern = new DecimalFormat("############.############");
```
Button Array

The calculator application will use a button array to construct the button 0 – 9, the decimal point, equal sign, addition sign, subtraction sign, multiplication sign and the division sign. There will be 16 buttons needed in all. Using a button array for the button will allow for the same code to be used when the button is clicked. The construction of the numeric keys can be done in a for loop with two lines of code. Other wise it would take 10 lines of code. No curly brackets are needed for the for loop because there is only 2 lines of code. On line 81 String.valueOf(i) method converts the numeric value of I to a string. Now the button values will be labels. The other buttons need to be assigned to the index numbers because each one has a unique string value. Line 91 set the layout of the Frame to BorderLayout and line 92 sets the layout of the keypad Panel to GridLayout with four rows and four columns. The 10, 10 is the amount of space between the buttons.

```java
// construct and assign captions to the Buttons
for (int i=0; i<=9; i++)
    keys[i] = new Button(String.valueOf(i));
keys[10] = new Button("/");
keys[12] = new Button("");
keys[13] = new Button("-");
keys[14] = new Button("=");
keys[15] = new Button(".");

// set Frame and keypad layout to grid layout
setLayout(new BorderLayout());
keypad.setLayout(new GridLayout(4,4,10,10));
```

Add Components to the Interface

When adding the components to the layout it is helpful to draw the layout on paper and assign the index numbers to each button. The mockup below gives a clear picture of what button goes where. Note that the order of most of the buttons of the last row is in descending order.
The reason for using the for loop is to cut down on the number of lines of code to build the interface. Where each for loop is adding three or four buttons at a time, that would save about ten extra lines of code. The for loop on lines 94 and 95 adds the first row of buttons to the grid. The first row will be buttons 7, 8, 9, and /. The second row will be the same adding 4, 5, and 6. On line 100 the index number 11 is adding the multiply sign to the second row. It cannot be added in the loop because of the order. In row 3 the same situation occurs where the first three buttons can be added in the loop but the number of the fourth button, 12, cannot be added in the sequence and needs to be added on its own in line 105. The forth row first adds the index 0 on line 107 and then on line 109 in descending order adds the decimal point, equal sign and the plus sign using i—instead of i++.

```
93
94    for (int i=7; i<10; i++)    // 7, 8, 9, divide
95        keypad.add(keys[i]);
96
97    for (int i=4; i<6; i++)      // 4, 5, 6
98        keypad.add(keys[i]);
99
100    keypad.add(keys[11]);    // multiply
101
102    for (int i=1; i<4; i++)    // 1, 2, 3
103        keypad.add(keys[i]);
104
105    keypad.add(keys[12]);    // subtract
106
107    keypad.add(keys[0]);      // 0 key
108
109    for (int i=15; i>=13; i--)
110        keypad.add(keys[i]);  // decimal point, =, add (+) keys
```

In the next lines of code the ActionListener is added to each button using a for loop. The loop on line 112 goes from 0 to the end of the array using the `length` property of the array. The keyword `this` refers to control back to it’s self or in this case the buttons are the keys. On line 115 the TextField `lcd` is added to the north region of the BorderLayout and line 116 adds the keypad to the Center region of the BorderLayout.

```
111
112    for (int i=0; i<keys.length; i++)
113        keys[i].addActionListener(this);
114
115    add(lcd, BorderLayout.NORTH);
116    add(keypad, BorderLayout.CENTER);
```

The panel is now complete with 16 buttons added to create the keypad. The panel is a composite component or a container with components added to it. When the panel is added to the frame all the buttons are added at once.
On line 118 the WindowListener is added and registered to the Frame. This connects the two objects together so that events from the Frame object are sent to the listener. The listener tells the Frame object to listen for an event and respond accordingly. The argument inside the parentheses for the addWindowListener, lines 119 – 126, creates a new instance of the WindowAdapter class. The WindowAdapter class provides the window event handling. In this case allows the user to click the X to terminate the program.

```java
addWindowListener{
    new WindowAdapter()
    {
        public void windowClosing(WindowEvent e)
        {
            System.exit(0);
        }
    }
}
```  // end of constructor method

This program uses the Clipboard class to copy and paste the calculation results. The clipboard is a temporary area of memory reserved for user storage. The Toolkit class is also used to be able to transfer the data back and forth using cut, copy and paste. The table below displays some of the methods used from the Clipboard.

<table>
<thead>
<tr>
<th>Method</th>
<th>Use</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>getDefaultToolkit()</td>
<td>Gets the system toolkit if it exists.</td>
<td>Toolkit myTools = Toolkit.getDefaultToolkit();</td>
</tr>
<tr>
<td>GetSystemClipboard()</td>
<td>Gets the most resent value of the system</td>
<td>Clipboard cb = myTools.getSystemClipboard();</td>
</tr>
<tr>
<td>getContents()</td>
<td>Returns transferable object from the</td>
<td>Transferable fromCb = Cb.getContents(this);</td>
</tr>
<tr>
<td></td>
<td>clipboard</td>
<td></td>
</tr>
<tr>
<td>setContents()</td>
<td>Sets transferable object from the</td>
<td>Transferable ToCb = Cb.setContents(this);</td>
</tr>
<tr>
<td></td>
<td>clipboard</td>
<td></td>
</tr>
<tr>
<td>getTransferData()</td>
<td>Returns data to be transferred.</td>
<td>String s = (String) Content.getTransferData</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(DataFlavor.stringFlavor);</td>
</tr>
</tbody>
</table>
Exit and Clear Commands

The code below will be performed if the menu items Exit or Clear are clicked. The getActionCommand is assigned the string value of \texttt{arg}. Then on line 134 the \texttt{arg} is compared to the key work Exit. If it is a match then the System.exit(0) method is called and the program ends. If \texttt{arg} equals Clear then all the variables listed are set to zero or null and the focus is put back to the lcd TextArea so a new calculation can begin.

```java
130 public void actionPerformed(ActionEvent e)
131 {
132     //test for menu item clicks
133     String arg = e.getActionCommand();
134     if (arg == "Exit")
135         System.exit(0);
136     if (arg == "Clear")
137     {
138         clearText = true;
139         first = true;
140         op1 = 0.0;
141         lcd.setText("" );
142         lcd.requestFocus();
143     }
144     }
145
If Copy is selected for the menu, then the Clipboard is activated and the contents is sent to the clipboard. When Paste is selected for the menu the contents of the Clipboard is transferred. On line 157 the try block is activated. It is parsed, formatted and then sent to the lcd TextField. If it can’t do the action, then the catch is thrown, an error and the lcd is set to null. If the About menu item is selected Then a message box will be shown with the text that has been assigned to the message.

```java
146     if (arg == "Copy")
147     {
148         Clipboard cb = Toolkit.getDefaultToolkit().getSystemClipboard();
149         StringSelection contents = new StringSelection(lcd.getText());
150         cb.setContents(contents, null);
151     }
152     if (arg == "Paste")
153     {
154         Clipboard cb = Toolkit.getDefaultToolkit().getSystemClipboard();
155         Transferable content = cb.getContents(this);
156         try
157         {
158             String s = (String)content.getData(DataFlavor.stringFlavor);
159             lcd.setText(calcPattern.format(Double.parseDouble(s)));
160         }
161         catch (Throwable exc)
162         {
163             lcd.setText("" );
164         }
165     }
166     if (arg == "About")
167     {
168         String message = "Calculator ver. 2.0\n\nCopyright 2009\nAll rights reserved";
169         JOptionPane.showMessageDialog(null, message,
170             "About Calculator", JOptionPane.INFORMATION_MESSAGE);
171     }
172 ```
Number Button

Line 177 test if a button has been clicked. The foundKey is set to false first to prevent errors in the later code. If a user clicks in the frame or title bar it may be set to true otherwise. Next the array is searched to see if a button has been selected on line 180. If the source stored in the variable e matches one of the buttons the code inside the block begins. Java uses a switch case statement to test a variable against multiple possibilities. Typically each case ends with a break command that is displayed on line 196. In this case where the user can click on a button 0 – 9 and the period on line 188 all of the cases are together. This will allow the same function for any on the keys. First the lcd is set to null and then the clearText is set to false. On line 195 the label of the button is displayed in the lcd. If multiply buttons are selected the getLabel() method is concatenated with the previous text in the lcd.

```java
    // test for button clicks
    foundKey = false;
    // search for the clicked key
    for (int i=0; i<keys.length & & !foundKey; i++)
    {
        if (e.getSource() == keys[i])
        {
            foundKey=true;
            switch(i)
            {
                // number and decimal point buttons
                case 0: case 1: case 2: case 3: case 4: case 5: case 6: case 7:
                case 8: case 9: case 15:
                if (clearText)
                {
                    lcd.setText(" ");
                    clearText = false;
                }
                lcd.setText(lcd.getText() + keys[i].getLabel());
                break;
            }
        }
    }
```

First Operator Button Click

The array is searched for the operator buttons and adds functionality to the buttons within the actionPerformed() method. On line 199 if a case is selected that would mean a user has selected one of the buttons with the index values of 10 – 14. On line 200 the clearText is set to true. The value from the lcd is parsed and then stored in the variable op1. On line 207 the first variable is set to false and the next line the clearText is set to true and the index of the operator is saved in lastOp for later use.

```java
    // operator buttons
    case 10: case 11: case 12: case 13: case 14:
        clearText = true;
        if (first) // first operand
        {
            if (lcd.getText().length()==0) op1 = 0.0;
            else op1 = Double.parseDouble(lcd.getText());
            first = false;
            clearText = true;
            lastOp = i; // save last operator
        }
```
Second Operator and Equal Sign

Line 211 will execute if the variable called first is false. Line 213 continues with the switch structure using the variable lastOp. The program test what operator has been selected with each case. Depending on which operator has been selected, the input is parsed and the arithmetic is preformed and stored in the variable op1. Line 228 formats the results and set clearText to true. There is no case for the equal button. Because there is no case 14 the code will pass directly to line 231 skipping all of the other code if no other button has been selected.

```java
else // second operand
{
    switch(lastOp)
    {
        case 10: // divide button
            op1 /= Double.parseDouble(lcd.getText());
            break;
        case 11: // multiply button
            op1 *= Double.parseDouble(lcd.getText());
            break;
        case 12: // minus button
            op1 -= Double.parseDouble(lcd.getText());
            break;
        case 13: // plus button
            op1 += Double.parseDouble(lcd.getText());
            break;
    } // end of switch(lastOp)
    lcd.setText(calcPattern.format(op1));
    clearText = true;
    if(i==14) first = true; // equal button
    else lastOp = i; // save last operator
} // end else
break;
}
} // end of switch(i)
} // end of if
} // end of for
} // end of actionPerformed

The main() Method

The main() method of the Calculator application constructs an instance of the Calculator class and then sets three attributes. Line 243 an instance of the Frame named f is constructed. The next line sets the title to the frame. In line 245 setBounds() method sets the frame to display 300 pixels from the top and 300 pixels from the left of the screen and 200 pixels wide and 200 pixels high. The setVisible() method on line 246 will cause the frame to be displayed at the beginning of the application. The setVisible() method can be used with frames to determine when you want a frame to be displayed. Line 249 set the image to an icon and assigns the image to the frames title bar.

```java
public static void main(String args[])
{
    // set frame properties
    Calculator f = new Calculator();
    f.setTitle("Calculator Application");
    f.setBounds(200,200,300,300);
    f.setVisible(true);

    // set image properties and add to frame
    Image icon = Toolkit.getDefaultToolkit().getImage("calcImage.gif");
    f.setIconImage(icon);

} // end of main
} // end of class
Programming Assignment

1. Recreate ArrayExamples.
2. Recreate the Calculator application.
3. Extra credit will be given for the following:
   a. Changing the colors of the buttons
   b. Changing the general layout.
   c. Any code implemented that works that we haven’t used yet.